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Restart the computer in Safe Mode

Restart the computer in Hibernate Mode

Shut down the computer terminating all the running applications

A power-off mode that preserves the last state of the computer

1/1

the rows and columns

the workbook

the active cell

the label
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1. What is the meaning of 'Hibernate' in Windows?
1. Windows में हाइबरनेट से क्‍या तात्‍पर्य है?

*

2. In MS-Excel, ________ contain(s) one or more worksheets.
2. Ms excel के  -------- में एक या अधिक वर्क शीट्स होती हैं।

*
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/mnt

/kernel

/usr

/dev

1/1

characters

letters

symbols

words

1/1

LINEST function

TREND function

LN function

LINT function

3. Which of the following directories is used as a temporary mount point
for mounting storage devices, such as CD-ROMs, floppy disks and USB
(universal serial bus) key drives, in Linux?
3. लिनक्‍स में सीडी – रोम , फ्लॉपी डिस्‍क और यूएसबी (यूनिवर्सल सीरियल बस ) की
ड्रा इव जैसे माउं टिंग स्‍टोरेज डिवाइस के  लिए निम्‍न में से कौन सी डायरेक्‍टरी अस्‍थायी
माउंट पांइंट के  रूप में उपयोग की जाती है?

*

4. The speed of a dot matrix printer is measured in ______ per second.
4. डॉट मैट्रि क्‍स प्रिंटर की गति ----------- प्रति सेकं ड में मापी जाती है।

*

5. Which of the following returns the values along a linear trend in MS-
Excel?
5. Ms excel में , कौन सा फं क्‍शन किसी रेखीय प्रवृति के  मापदंड देता है?

*
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Program

Record

Field

Component

1/1

Track ball

Scanner

Mouse

Joystick

1/1

the circuit board that houses peripheral devices

same as the CPU chip

memory chip

the circuit board that contains a CPU and other chips

6. Which of the following is a specific instruction given to a computer
application to perform some kind of task or function?
6. किसी भी प्रकार का कोई काम संपन्‍न करने के  लिए कं म्‍प्‍यूटर प्रोग्राम को दिया गया
एक विशिष्‍ट निर्देश क्‍या कहलाता है?

*

7. Which of the following is NOT a pointing device for providing input to
the computer.
7. निम्‍नलिखित में से कौन सा कं म्‍प्‍यूटर को इनपुट प्रदान करने के  लिए एक पॉइं टिंग
डिवाइस नहीं  है?

*

8. The motherboard is:
8. मदर बोर्ड क्‍या होता है?

*
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Multimodal biometric system

Privacy and discrimination

Access control

Cancelable biometrics

1/1

Data Sharing

Addressing

Power

Connects memory to disk

1/1

Reliable printers and inexpensive

Not noisy

Make continuous prints on paper

The cost of printouts is cheaper

9. ______ can add more complexity to the standard process of biometrics
by the combining of more than one biometric modality; for example,
combining a fingerprint with an iris scan.
9. बायोमेट्रि क्‍स की मानक प्रक्रिया को एक से अधिक बायोमेट्रि क विधियाँ जैसे कि
फिं गरप्रिंट के  साथ आँख की पुतली के  स्‍कै न के  संयोजन से और जटिल बनाने की प्रक्रिया
कहलाती है?

*

10. Which of the following is NOT a function of System bus?
10. निम्नलिखित में से कौन सा सिस्‍टम बस का कार्य नहीं  है?

*

11. Which of the following is NOT a characteristic of impact printers?
11. निम्‍न में से कौन सी इम्‍पैक्‍ट प्रिंटरों की एक विशेषता नहीं  है?

*
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Seamless card reader

Design card reader

Graphics card reader

Contactless card reader

1/1

analog signal

digital signal

electromagnetic signal

electrical signal

1/1

1110

1101

1000

0111

12. Which of the following is a type of reader uses radio frequency to
communicate, when the card is bought close to the reader?
12. कार्डों को जब रीडर के  पास लाया जाता है, तो रीडर संचार के  लिए निम्‍नलिखित में से
किस रे डियो आवृति का उपयोग करते हैं?

*

13. A passive digital tablet generates a(n) ______. This signal is received
by the LC circuit in the stylus.
13. पैसिव डिजिटल टैबलेट एक ---------- उत्‍पन्‍न करता है। यह सिग्‍नल LCपरिपथ में
स्‍टाइलस द्वारा ग्रहण किया जाता है।

*

14. What will be the result of addition of given binary numbers (101)2 and
(11)2?
14. दी गई द्विआधारी संख्‍याओं (101)2 और (11)2 को जोड़ने का परिणाम क्‍या होगा ?

*
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Solid State Drive

Structure State Drive

Synchronous State Drive

Solid Synchronous Drive

1/1

Spoof

Access

Firewall

Virus

1/1

CMOS

Fan

Compiler

The Master Boot Record (MBR)

15. What is the full form of SSD with reference to storage devices of a
computer?\
15. कं म्‍प्‍यूटर की स्‍टोरेज डिवाइस के  संदर्भ में SSDका पूर्णरूप क्‍या है?

*

16. ______ refers to the hacking or deception that imitates another person
with the intentions of bypassing security measures.
16. ------------ हैकिं ग या धोखे को संदर्भित करना है जो सुरक्षा उपायों को दरकिनार करने
के  इरादे  से किसी अन्‍य व्‍यक्ति का अनुकरण (नकल) करता है।

*

17. ________ is a small program that starts when the computer is booting,
in order to find the operating system
17. --------- एक छोटा सा प्रोग्राम है जो ऑपरे टिंग सिस्‍टम को खोजने के  लिए कं म्‍पयूटर
के  बूट होने पर शुरू होता है।

*
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Statistical

Engineering

Math and Trigonometry

Text

1/1

JAVA

C

C++

COBOL

1/1

hardcopy

softcopy

copy on disk

copy on CD

18. In MS-Excel, in which category of functions does FREQUENCY
command belongs to?
18. Ms excel में , frequency कमांड किस श्रेणी के  फं क्‍शन से संबंधित है?

*

19. James Gosling is generally known best as the founder or creator of
the ______ programming language.
19. जेम्‍स गोसलिंग को आम तौर पर ---------- प्रोग्रामिंग भाषा के  संस्‍थापक या निर्माता के
रूप में जाना जाता है।

*

20. The printer is a device used to produce:
20. प्रिंटर एक उपकरण है‍ जिसका उपयोग ---------- उत्‍पादन के  लिए किया जाता है।

*
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Large optical device memory

Secondary memory can be used as if it were a part of the main memory

Large disk memory

Large secondary memory

1/1

RAM

ROM

Memory

Accumulator

1/1

Speaker

Word

Scanner

Printer

21. Virtual memory is ______.
21. वर्चुअल मेमोरी ----------- है।

*

22. _______ is the main register in the ALU and contains one of the
operands of an operation to be performed in the ALU.
22. ----------- ALU में मुख्‍य रजिस्‍टर है और इसमें ALU में किए जाने वाले ऑपरेशन के
ऑपरेंड में से एक होता है।

*

23. Which of the following is an input device?
23. निम्‍नलिखित में से कौन सा , एक इनपुट डिवाइस है?

*
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Aero Peek

Home Button

Windows

M Key

1/1

MROM

PROM

EPROM

EEPROM

1/1

Memory

System Calls

Client

Administrator

24. _______ is a feature in Windows 7, Windows 8, or Windows 10 that
enables user to get back to the desktop swiftly.
24. –-------------- , विंडोज 7, विडोज 8 या विंडोज 10 में एक फीचर होता है जो उपयोग
कर्ता को डेक्‍सटॉप पर तेजी से वापस आने में सक्षम बनाता है।

*

25. Choose the ROM type in which electric field is applied to erase data?
25. वह ROM प्रकार चुनें जिसमें डेटा मिटाने के  लिए विद्यु त क्षेत्र लगाया जाता है?

*

26. To access the services of the operating system, the interface is
provided by the _______.
26. ऑपरे टिंग सिस्‍टम की सेवाओं तक पहुंचाने के  लिए , इंटरफे स ------------ द्वारा प्रदान
किया जाता है।

*
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Iris effect

Gabber effect

Avalanche effect

Newton effect

1/1

macro

read

script

login

1/1

Statistical

Lookup and Reference

Text

Logical

27. In DES, due to the _____________ a small change in the plaintext results
in a very great change in the ciphertext.
27. डी. ई. एस. (DES) में ---------- के  कारण प्‍लेनटेक्‍स्‍ट में छोटा सा बदलाव
साइफरटेक्‍स्‍ट में बहुत बड़ा परिवर्तन लाता है।

*

28. In Linux, which command is used to record a user login session in a
file?
28. लिक्‍न्स में , किस कमांड का प्रयोग किसी फाइल में यूजर लॉगिन सेशन को रिकॉर्ड
करने के  लिए किया जाता है?

*

29. In MS-Excel, In which category of functions does "IFERROR" belongs
to?
29. Ms excel में, “IFERROR” किस श्रेणी के  फं क्‍शन से संबंधित है?

*
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Math and trigonometry

Statistical

Text

Engineering

1/1

Sending an email to your friend

A government employee reserving a hotel room over the internet

An individual paying his electricity bill through the Internet

An individual purchasing a book over the Internet

1/1

netload

upload

download

link load

30. In MS-Excel, In which category of functions does "HEX2BIN" belongs
to?
30. Ms excel में , “ HEX2BIN” किस श्रेणी के  फं क्शन से संबंधित है?

*

31. Which of the following is NOT an example of E-commerce?
31. निम्‍नलिखित में से कौन्‍ सा , ई- कॉमर्स का एक उदाहरण नहीं  है?

*

32. The process of copying a document from your Google Drive account
to your flash drive is called:
32. किसी डॉक्‍यूमेंट को आपके  google ड्रा इव खाते से आपके  फ्लैश ड्रा इव में कॉपी
करने की प्रक्रिया क्‍या कहलाती है?

*
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TCP

ISP

FTP

HTTP

1/1

high-level

low-level

medium-level

machine

1/1

Very Small Aperture Terminal

Very Small Alternative Terminal

Very Small Asynchronous Trading

Very Small Aggressive Terminal

33. Which of the following provides Internet access to users?
33. निम्‍न में से कौन सा , उपयोग कर्ताओं को इंटरनेट एक्‍सेस प्रदान करता है?

*

34. Assembly language is a ______ programming language.
34. असेंबली भाषा एक ---------- प्रोग्रामिंग भाषा है।

*

35. What is the full form of VSAT?
35. VSAT का पूर्ण रूप क्‍या है?

*
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ABraCaDabrA

abracaDabra

aBracadabra

AbRAcAdABRA

1/1

next page

continuous

even page

odd page

1/1

String sensitive

Match string

Case sensitive

Match case

36. The toggle case applied to “aBraCaDabra is -
36.  “aBraCaDabra” पर लागू होने वाला टॉगल के स है?

*

37. A(n) _______________ section break starts a new section on the same
page in MS-Word.
37. एक---------- सेक्‍शन ब्रेक ms word में उसी पेज पर नया सेक्शन शुरू करता है।

*

38. Which of the following options makes a search task case sensitive in
the 'Find & Replace' dialog box?
38. निम्‍नलिखित में से कौन सा विकल्‍प , ‘find and replace ‘ डॉयलॉग बॉक्‍स में खोज
कार्य (सर्च टास्‍क ) के स सेंसिटिव बनाता है?

*
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Alt + Click

F7

Shift + F7

Ctrl + Click

1/1

Windows XP

Windows 95

Windows 98

Windows 99

1/1

Tight

Compact

Double

Close

39. In MS-Word, the keyboard shortcut to open the Thesaurus task pane
of Proofing tab is ________________.
39. Ms word में, अशुद्वि जांच ( प्रूफिं ग टैब ) के  थिसॉरस टास्‍क पेन को खोलने के  लिए
की बोर्ड शॉर्टकट --------- है।

*

40. Which of the following is NOT a valid Windows operating system
version?
40. निम्‍नलिखित में से कौन सा , वैध्‍ विंडोज ऑपरे टिंग सिस्‍टम संस्‍करण नहीं  है?

*

41. Which of the following is NOT an option for Paragraph spacing in MS-
Word.
41. Ms word में पैराग्राफ स्‍पेसिंग के  लिए निम्‍नलिखित में से कौन सा विकल्‍प नहीं  है।

*
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a different

the same

a default

red

1/1

Proofing

Comments

Tracking

Changes

42. If there are multiple reviewers of an MS-Word document, each person
will be assigned _____________ markup color for track changes.
42. यदि ms word दस्‍तावेज के  कई समीक्षक (reviewers ) हैं, तो प्रत्‍येक व्‍यक्ति को
ट्रै क परिवर्तनों के  लिए ----------- मार्क अप रंग दिया जाएगा।

*

43. The given commands are a part of the _________ group in the Review
tab of MS-Word.
43. दिए गए कमांड एमएस वर्ड के  रिव्‍यु टैब में --------- ग्रुप का हिस्‍सा है।

*
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Switched Mode Power Supply

Synchronous Mode Power Supply

Switch Method Power Supply

Switch Mode Power Supplement

1/1

Envelopes

Labels

Letters

Pages

1/1

Document area

Status bar

File tab

Quick Access Toolbar

44. What is the full form of SMPS with reference to PC operation?
44. Pc ऑपरेशन के  संदर्भ में SMPS का पूर्ण रूप क्‍या है?

*

45. In MS-Word, the option which is NOT available in “Start Mail Merge”
is-
45. Ms word में “start mail merge “  में जो विकल्‍प उपलब्‍ध नहीं  होता है, वह है?

*

46. Which of the following is a convenient resting place for the most
frequently used commands in MS-Word?
46. निम्नलिखित में से कौन सा ms word में सबसे अधिक (बार बार ) उपयोग किए जाने
वाले कमांड के  लिए सुविधाजनक विश्राम स्‍थल ( resting place) है?

*



1/1

Read

Write

Draft

Print Layout

1/1

Page Number from Insert menu

Page Setup from File menu

Footnote from Insert menu

Page Number from Design menu

1/1

It inserts spaces between words

It aligns text with the right margin

It forces all text to be confined within defined margins

It combines and centres the content of the selected cells

47. In MS-Word, ____________ mode is used to hide the writing tools and
menus and to leave more room for the pages themselves.
47. Ms word में , ------ मोड का उपयोग राइटिंग टू ल्‍स और मेन्‍यू को छिपाने के  लिए
और स्‍वयं पृष्‍ठों के  लिए अधिक जगह छोड़ने के  लिए किया जाता है।

*

48. There are many ways to insert a page number in an MS-Word
document. Which of the following steps lets you insert a page number?
48. Ms word डॉक्‍यूमेंट में, पेज संख्‍या इन्‍सर्ट करने के  कई तरीके  हो सकते हैं ।
निम्नलिखित में से कौन सा चरण आपको पेज संख्‍या इन्‍सर्ट करने में सहायता करता है?

*

49. The task performed by the "Wrap Text” feature in MS-Word is?
49. Ms word में “wrap text” फीचर द्वारा किया जाता वाला कार्य है?

*
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Downloading

Uploading

Reloading

Indexing

1/1

download

upload

execute

delete

1/1

Dell

IBM

Microsoft

Intel
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50. Ashish wants to install a flash player from the Internet where the
setup link is available. Which process should he use to save the setup on
his computer?
50. आशीष इंटरनेट से एक फ्लैश प्‍लेयर स्‍थापित (install) करना चाहता है जहां सेटअप
लिंक उपलब्‍ध है। सेटअप को अपने कं म्‍प्‍यूटर पर सेव करने के  लिए उसे किस प्रक्रिया का
उपयोग करना चाहिए ?

*

51. An anonymous FTP server allows you to only ______ the files on the
client machine without creating any account.
51. एक अनाम ( anonymous )FTP सर्वर आपको बिना कोई खाता क्‍लाइंट मशीन पर
के वल फाइलों को ------------- करने की अनुमति देता है।

*

52. Who among the following introduced the first commercial hard disk?
52. निम्‍नलिखित में से किसने पहली कमर्शियल हार्ड डिस्‍क पेश की थी ?

*
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